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سومین شماره مجله مجازي عكاسي و گرافيك فتوگراف را ورق مي زنيد و لطف خدا و تلاش همكاران
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متشكريم.
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سرمقاله

مرز های اخلاق در عکاسی

عکاسی ثبت لحظه ای از حقیقت است. لحظه ای که قصه ای در خود دارد و آن قصه جز به زبان تصویر تمام و کمال بازگو نمی شود. تصویر حاصل غم، شادی، ترس و 
خشم را با وجود گذر زمان آنچنان که باید بیان می کند و گاهی دنیا را تکان می دهد. عکس معروف اعدام خیابانی ویت کنگ، که روی جلد کتاب »زندگی، جنگ و دیگر 
هیچ«،اثر»اوریانا فالاچی« است یادآور همین نکته است. در این تصویر رئیس پلیس ویتنام؛ ژنرال »لون« اسلحه را به سمت اسیر ویت کنگ هدف گرفته است.  این عکس 
به یکی از معروفترین عکس های ضد جنگ بدل شد و بسیاری معتقدند انتشار آن سبب فشار بسیار به دولت آمریکا برای پایان دادن به جنگ ویتنام شد. »ادی آدامز « 

عکاس جنگ به خاطر این عکس برنده جایزه پولیتزر شد. 
آدامز درباره این عکس می گوید :» ...آماده عکس گرفتن بودم؛ از سمت چپ دریچه دوربینم مردی را دیدم که به صحنه آمد. تپانچه اش را بالا آورد. گرفتن تپانچه بروی 
سر اسرا در حین بازجویی عادی بود، آماده بودم که چنین عکسی بگیرم، تهدید، بازجویی! اما آن اتفاق نیافتاد. آن مرد تپانچه را از جلدش بیرون آورد. ویت کنگ سرش را 
بالا گرفت و او به گیجگاهش شلیک کرد و من در همان زمان عکس گرفتم. واقعا نمی دانستم که او قصد شلیک کردن دارد. اسیر بر روی سنگفرش افتاد و خون از سرش 

فوران می کرد.«
ژنرال، ویت کنگ را کشت و صد ها انسان دیگر را، اما در عین حال این عکس آدامز، ژنرال لون را کشت و این قدرت تصویر است. با این تفاسیر عکاس نمی توانست به 

اسیر به طور مستقیم با دخالت در شرایط سوژه به ویت کنگ یاری رساند و تکیه به دوربینش، غیر مستقیم کمک بزرگی به همه مردم ویتنام بود.
در مقابل این، عکسی است که خشم دنیا را بر می انگیزد به این دلیل که دخالت در شرایط سوژه به عکاسی ارجح تر بوده اما عکاس به این امر مبادرت نورزیده است. عکسی 
که کوین کارتر در سال 1993 در سودان گرفت از این دست تصاویر است. در این عکس کودکی نیمه جان در نزدیکی یک مرکز امداد رسانی دیده می شود. لاشخوری در 
نزدیکی کودک به انتظار مرگ او نشسته است. گفته می شود که کارتر 20 دقیقه انتظار کشید تا لاشخور بال هایش را باز کند تا عکسش نمود بیشتری پیدا کند. اما این 

اتفاق نمی افتد و عکاس به گرفتن عکس در همان حالت راضی می شود. لاشخور را دور می کند و خود می رود.
این تصویر باعث شد جهان از آنچه در سودان می گذرد آگاه شود اما سبب ایجاد بحث هایی نیز راجع به چرایی عدم کمک عکاس به کودک شد.

»سن پترزبورگ تایمز« درباره این عکس نوشت که عکاس با تنظیم دقیق لنز و انتظار بیست دقیقه ای اش، در حکم لاشخور دوم صحنه بود. کارتر هم دو ماه بعد از 
گرفتن جایزه پولیتزرش خودکشی کرد.

در این زمینه عکاسان )به خصوص عکاسان اجتماعی،خبری و جنگ( در تلاش اند تا مسئولیت اجتماعی خود را در برابر جامعه به درستی نشان دهند. آنها در این مسیر با 
دوراهی های اخلاقی زیادی روبرو می شوند. شناخت این دو راهی ها عکاسان را وادار به انتخاب درستی  و  نادرستی ابعاد اخلاقی می کند. شناخت مرز و حدود اخلاقی 

برای هنر فعل آسانی نیست. گاه باید رسالت عکاسی را به انجام رساند و خبررسان بود و گاه باید در جایگاه یک انسان دست به دخالت در شرایط زد.
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شاید افلاطون، فیلسوف بزرگ یونانی بهترین اظهار نظر را در مورد 
جنگ میگفت او زمانی اظهار داشت که “که تنها مردگان پایان جنگ 

را دیده اند.” 
در فرهنگ ها و سرزمین های مختلف جنگ ، مبارزه ، پرخاشگری 
و ... را به شیوه های گوناگون تفسیر و تعریف می کنند از گذشته 
داستان ها و خاطراتی می آید که به آینده میرود . کتاب هایی نوشته 
فیلم   ، ، عکسهایی گرفته شدن  ترسیم شدن  نقاشی هایی   ، شدن 
هایی ساخته شدن و اکنون تصاویری طراحی شده اند که همه اینها 
دنیای سینما  بشه گفت که  ، شاید  میکنند  را جذب  مخاطبان خود 
پر کار ترین بوده است در به پرده در آوردن جنگ ها از فیلم هایی 
که سالانه ساخته میشوند و علاقمندان بسیاری را به پای سینما ها 

میکشند.
میرسیم  دیجیتال  هنر  دنیای  به  بگذریم  که  اینها  ی  همه  از  اما   
بین  در  زود  توانست خیلی  مورد جنگ  در  آثار خود  با  که  دنیایی   ،

مخاطبان جای بگیرد.

جنگ در گرافکی

Jason Engle : جنگ خونین   /   طراح
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امروز میبینیم که بازی های کامپیوتری زیبا و زیاد جنگی ساخته میشوند 
و روز به روز به واقعیت نزدیک میشوند. در این بخش از مجله ما بهترین 

تصاویر جنگی طراحی شده را برایتان به نمایش میگذاریم. 

Kerem Beyit : کمین     /      طراح lasahido : آخرین نبرد     /      طراح

 Henryz : سن غارتگران را فراموش کرده اید     /      طراح
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WraithDT Beyit : چشمه     /      طراح Rado Javor : نبرد     /      طراح

Michael Kutsche Beyit : امپراتوری های جنگ     /      طراح

امروزه دنیای گرافیک کامیپوتری یا به اصطلاح CG  انقدر پیشرفت کرده 
است که مخاطبان خیلی زیادی برای یادگیری به این حرفه را به سوی خود 
کشانده ، نرم افزار های طراحی هم روز به روز در حال پیشرفت و تکمیل 
جزئیات خود هستند .  برای دوستانی که مایل به یادگیری این حرفه هستند 
باید گفت که اکثر کاراکتر های 3D را با یکی نرم افزار های  3D زیر 

طراحی شده اند  : 
                    Pixologic zBrush, Autodesk 3D Studio Max,

Mudbox or Maya, Daz Studio, Poser و غیره .

طراح حرفه ای سه بعدی و هنر عکس 
های دیجیتال 

طراح حرفه ای سه بعدی و هنر عکس 
های دیجیتال 
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با این نرم افزار ها میتونیم ترکیبی از مدل سازی 3D، بافت و رندر واقع 
استفاده  رئالیسم در دنیای گرافیک کامپیوتری  برای  بینانه و بی نظیر 
از شخصیت های معروف مدل  از چهره خیلی  امروزه  . طراحان  کنیم 
به  را  همگان  نظر  که  اند  کرده  طراحی  گرافیکی  و  کامپیوتری  های 

خودشان جلب می کند .
و  گرا  فانتزی  که   حالی  در  گرایانه،  واقع  تصویر  چند  قسمت  این  در 
جادویی ، که در یک چیز مشترک اند ، همه آنها فوق العاده دقیق هستند 

را برای شما ارائه خواهیم داد.

 طراح : Addy   /   از آمریکا  /  طراح حرفه ای سه بعدی و هنر عکس های دیجیتال طراح : Jaime Jasso   /   از آمریکا
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 طراح : Nikita  /   از اوکراین   /  23 ساله طراح : jiri adamec   /   از جمهوری چک

 طراح : kauedalcin  /   از برزیل  /  21 ساله





گالری از عکس های کودکان
               ثبت شده از عکاسان خوب کشورمان .
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Camera NIKON D7000 

Focal Length 90mm

Shutter Speed 1/1250 sec 

Taken August 11th 2012

-----------------------------------------------------------

Copyright Mostafa Bazri

Camera NIKON D7000 

Focal Length 18mm

Shutter Speed 1/3200 sec 

Taken August 10th 2012

-----------------------------------------------------------

Copyright Mostafa Bazri
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Camera Canon EOS 5D 

Focal Length 120mm

Shutter Speed 1/1600 sec 

Taken  January 9th 2011

-----------------------------------------------------------

Copyright Mohammadreza Tavajjoh

Camera Canon EOS 7D 

Focal Length 70mm

Shutter Speed 1/5000 sec 

Taken  March 22nd 2011

-----------------------------------------------------------

Copyright Mohammadreza Tavajjoh
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Camera Canon EOS 5D 

Focal Length 175mm

Shutter Speed 1/2500 sec 

Taken  January 9th 2011

-----------------------------------------------------------

Copyright Mohammadreza Tavajjoh

Camera Canon EOS 5D 

Focal Length 125mm

Shutter Speed 1/2000 sec 

Taken  January 9th 2011

-----------------------------------------------------------

Copyright Mohammadreza Tavajjoh
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Camera PENTAX 645NII 

Focal Length 120mm

Shutter Speed 

Taken  8 months ago

-----------------------------------------------------------

Copyright Abbas Arabzadeh

Camera PENTAX 645NII 

Focal Length 120mm

Shutter Speed 1/125 sec 

Taken  September 19th 2010

-----------------------------------------------------------

Copyright Abbas Arabzadeh
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 Camera  PENTAX 645D             Focal Length 120mm               Shutter Speed 1/100 sec  

Taken  September 19th 2010        Copyright Abbas Arabzadeh
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 Camera  Canon EOS 5D Mark II            Focal Length 105mm        Shutter Speed 1/400  sec  

Taken  August 5th 2010                     Copyright Mypik@ymail..com
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ســـــــــوژه عـــــــــکاسی و طـــــــراحی آثــار طلائــــــــــی
شــــــــــــــــماره بعــــــــــــدی مجلــــــــه فتــوگــــــــراف
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گو
یـــک بــرزیلـــی

          با تــــــکنیــــک

تیا
 این بار نه در فوتبال بلکه در تصویر سازی



سایت ســــــی جی آرنـــا
با تیـــاگــو

گــــــفت  و گـــــــوی کــــــــوتاه

چه دلیل و انگیزه ای شما را به انتخاب این صنعت گرایش داد؟

 400 حدود  در  که  شدم،  بزرگ  برزیل  سواحل  در  کوچکی  شهر  در  من 
بازی  فوتبال  ام  دوران کودکی  در طول  است.   دور  سالوادور  از  کیلومتر 
انجام  که  بودند  کارهایی  ماهی  و  خرچنگ  گرفتن  و  ماهیگیری  کردن، 
آثار  با  که  بود  بودم. چهارده سالم شده  نقاشی کردن  و عاشق  دادم  می 
کاریکاتوریستی به نام  »ایکو« ، دنیای کاریکاتور را کشف کردم. کارهای  
ایکو در »وجا«، یکی از پر تیراژترین مجالات برزیل منتشر می شد. آن 
کاریکاتور ها برایم یلی لذت بخش بود و از آنجا بود که نقاشی کشیدن 
روزانه را آغاز کردم. ابتدا کارتون های ایکو را کپی  می کردم و رفته رفته 
کارتونیست های دیگر را شناختم و در سبک خودم پیشرفت کردم. زمانی 
که مطالعه طراحی گرافیک را شروع کرده بودم، هنوز فکر اینکه روزی به 
عنوان یک تصویرگر حرفه ای شناخته می شوم، به سرم خطور نمی کرد. 
من نقاشی می کردم چون این کار را دوست داشتم. عجیب این که ده سال 
بعد از اولین برخوردم با کاریکاتورهای ایکو در مجله وجا، از طرف همین 

مجله برای انتشار کارهایم دعوت شدم.
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تیاگو در  رشته گرافیک فارق التحصیل 
دانشگاه  شروع  از  قبل  حتی  او   ، شد 
به  و  آمیز  طنز  تصاویر  روی  مطالعات 
طول  در  و  داشت  کاریکاتور  خصوص 
تحصیلات دانشگاه جهت مطالعاتش را 
عوض نکرد  و بیشتر از خود ِ طراحی 
گرافیک، تمرکزش را روی تصویرگری 
طنزآمیز گذاشت . به خاطر این تمرکز 
خوشحال است. به طور طبیعی تخصص 
او در رشته تصویر گری را هدف قرار 
می دهد. خوشبختانه کار شخصی اش 
به  دارای هویتی خاص شد و کم کم 
انجام  ای  حرفه  کارهای  اولین  عنوان 

چند طرح را آغاز کرد.



چه دلیل و انگیزه ای شما را به انتخاب این صنعت گرایش داد؟

در حال حاضر در یک استودیوی تصویرگری در سائوپائولو به نام »تکنو ایمیج« مشغولم. من در استودیوی 
خودمان با چند تا از هنرمندان پر استعداد و مشهور در دنیای CG کار می کنم مثل »پدرو کنتی«،»لوکاس 

لیبولز« و»دیگو مایا«. اینکه در زمان کارم در میان آنها بودم خیلی خوب بود، چیزهای بسیاری از آنها یاد گرفتم. 
اگر کسی مشتاق این است که بیشتر درباره کار ما بداند می تواند  وبسایت ما

                                                                   www.technoimage.com  را ببیند.
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آیا پیش از تصویرگری دیجیتال ، اسکچ  ِ طرحتان را روی کاغذ می آورید؟ و به طور متوسط اتمام هر تصویر چقدر زمان می برد؟تی

من همیشه شیفته ی رئالیسم و حجم گرایی در نقاشی ها بوده ام. از زمانی که طراحی را آغاز کردم، تمرکز در مطالعاتم باعث درک رفتار 
و اثر نور و مواد مختلف شد. در ابتدا، کار من تنها در طراحی با مداد و گرافیت بوجود آمد و  من خودم را به ایجاد چیزی شبیه عکس 
های سیاه و سفید محدود می کردم. این کار را حدود چهار سال ادامه دادم تا زمانی که متوجه شدم من به درک کافی برای شروع کار 
با رنگ رسیده ام. اولین تجربیات من با سایه، مداد رنگی و آبرنگ بود. هنوز اوایل مطالعاتم روی آن تکنیک بود که فتوشاپ را کشف 
کردم. دیگر وقتم را به ادامه آن روش محدود نکردم، زیرا علاوه بر گرانی مواد و ابزار، با برنامه فتوشاپ هم می توانستم به خوبی  نقاشی 
و سایه هایی که با گرافیت می کشیدم را بهتر کار کنم و فقط رنگ ها را به کار بگیرم. به تریج کار پایه ای با مداد برای من ساده سازی 
شد و کارم با فتوشاپ را خیلی بیشتر کردم. من اولین تبلتم را زمانی خریدم که مهاجرتم به کار با فتوشاپ، پایان یافته بود و هنوز همه 

کارهایم را با کامپوتر انجام می دادم.
مشخص کردن مدت زمان انجام و تکمیل یک کار سخت است  و تا حد زیادی به پیچیدگی تصویر و امتیاز پایانی آن وابسته است. به 
عنوان یک زمان متوسط، برای من تصویرگری کارهایی مثل »گرگ بزرگ بد«، »پسر نوجوان« و یا »وقت نهار« دو تا سه هفته طول 

کشید.



سفینه فضایی
ساخت یک تصویر خارق العاده از یک سفینه در 

Adobe illustrator

 Adobe illustrator CS5 نام برنامه: نرم افزار

سطح آموزش : متوسط 

برآورد زمان اتمام: 50 دقیقه  

تعداد گام ها  : 10 تا

تعداد تصاویر آموزشی : 11 تصویر
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اینبار قصد داریم یک راکت فضایی درخشان و زیبا را به وسیله Adobe illustrator  وبا استفاده از تکنیکهای پیشرفته مانند:
opacity mask,  pattern brush, gradiant mesh خلق کنیم. 

گام 1

رسم بدنه راکت : 
ازابزار pen برای کشیدن یک پوسته ی خالی با سایز استاندارد  512pixel  استفاده میکنیم.یک 
راهنمای عمودی در میان تصویر تعبیه کنید و درست نیمی از پوسته ی سفینه را در سمت راست آن 

رسم کنید. )تصویر شماره 1(

سپس کپی )Ctrl+C( و چسباندن با )Ctrl+F(. یک چرخش به صورت عرضی و حرکت دادن آن 
به سمت چپ راهنما.   )تصویر شماره 2(

حالا پنجره،بالاترین نقطه را در نظر بگیرید،  )Ctrl+J(  را در روی 
در  فعال شود،  الصاق  یا   Join تا قسمت  دهید  فشار  کلید  صفحه 
کادری که نشان داده میشود گزینه ی Corner  را انتخاب کنید.

با این کار نوک راکت تیز میشود. اصلا قابل قبول نیست که یک 
راکت دارای نوکی قوسی شکل باشد.   )تصویر شماره 3(

 

تصویر 1

تصویر 2 تصویر 3

مجله تخصصی گرافیک و عکاسی فتوگراف / بهمن 1391 / سومین شماره / رایگان28

A
do

be
 il

lu
st

ra
to

r 
ش

وز
آم



گام 2

حالا به سراغ قسمت پایین راکت میرویم، همان حرکت قبلی اما اینبار در درون آن کادر گزینه ی Smoth  را انتخاب میکنیم. داشتن انتهای تیز هم برای 
سفینه قابل قبول نیست.

  Creat gradient mesh گزینه ی Object مشخصات پوسته کامل شد.آن را انتخاب کنید و از منوی
را انتخاب کنید.با توجه به تصویر بعدی اندازه های شبکه ها را تنظیم کنید. پیشنهاد ارائه شده در اینجا این 

است که تا حد امکان نقاط کوچکی داشته باشیم اما برای شروع رنگ آمیزی مناسب است.
  )تصویر شماره 4(

رنگ آمیزی ابتدایی پوسته : 
از Toolbar نشانگر سفید را بردارید )A( . تمامی نقاط موجود بر روی شبکه را در نظر میگیریم. 
سپس یک رنگ طوسی ملایم را انتخاب میکنیم. بگذارید تصمیم بگیریم که  نور از بالاترین 
قسمت سمت چپ وارد میشود. این بدان معنی است که ما باید سمت راست و قسمت های پایینی 
را تاریکتر کنیم. حال که پوسته به شکل منحنی است اگر انتهایی ترین قسمت از سمت چپ به 

طور خفیفی تیره تر نیز باشد یک نمای سه بعدی جالب ایجاد میشود. )تصویر شماره 5(

تصویر 4

تصویر5   
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حالا میخواهیم رنگ آمیزی را کمی بهبود بخشیم. از تصویر زیر به عنوان راهنما استفاده کنید.
.toolbar از mesh ابتدا دو شبکه ی عمودی اضافه کنید. با استفاده از ابزار 

احتیاج به این است که نقاط مرکزی در هر طرف را انتخاب کنیم و آنها را نسبت به نقاط اطرافشان 
روشن تر در نظر بگیریم. تصویر را مشاهده کنید. )تصویر شماره 6(

تصویر 6

تصویر 7 تصویر 8
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گام 3

رنگ کردن قوس یا کمان سفینه : 
بگذارید کمی رنگ اضافه کنیم، برای خاص شدن نوک سفینه آن را قرمز میکنیم. شبکه را انتخاب کنید 
سپس از این آدرس go to Object > Path > Offset Path برای گزینه )offset (0 را در نظر 

بگیرید. ما باید یک path دقیقا شبیه شبکه ها بسازیم: )تصویر شماره 7(
شکل کلی را قرمز کنید و یک دایره 

در نوک آن ترسیم کنید.  )تصویر شماره 8(



با در نظر گرفتن هر دو شکل Ctrl+7  را فشار دهید تا یک  Cilipping mask ساخته شود. تاریکی 
تصویر را از قسمت   Trancparenc palett به این شکل تنظیم کنید. حالا فقط نوک سفینه قرمز است. 

)تصویر شماره 9(

اضافه کردن پرچها :
پوسته شامل تعدادی صفحات آهنی است که توسط پرچ به هم متصل شده است که میخواهیم آنها را رسم 
کنیم.آیا دایره ای که برای کشیدن نوک قرمز سفینه رسم کرده بودیم به یاد دارید؟ یک کپی از آن بگیرید و 
آن را از کادر خودش خارج کنید. حالا مانند تصویر آن را به وسیله ی 3PX دوبار جابه جا کنید،یکبار درون و 

یکبار بیرون راس سفینه . )تصویر شماره 10(

از بین دایره ها مرکزی ترین را پاک و دو دایره دیگر را نگه دارید. 
یک نقطه مشکی کوچک رسم کنید و آن را به داخل Brushes palette  ببرید. کادری ظاهر میشود که از 

شما نوع brush را
 میپرسد، new pattern brush  را انتخاب کنید.

 )تصویر شماره 11(

تصویر 9

تصویر 10 تصویر 11

گام 4
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کادر بعدی به شما اجازه میدهد Scale و Space مورد نیاز را تنظیم کنید. )تصویر شماره 12(

تصویر 13 تصویر 14

تصویر 15

تصویر 12
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این نوع Brush  را بر روی دایره ها اعمال کنید، رنگ نقطه های دایره های بیرونی باید کمی تیره 
تر از رنگ بدنه ب و رنگ دایره درونی باید به رنگ قرمز تیره باشد. )تصویر شماره 13(

 .Object > Expand Appearance این آدرس بروید انتخاب کنید و به  هر دو دایره را 
سپس  Shift+Ctrl+G را بفشارید تا آن ها را از هم تفکیک کنید. حال میتوانید تمام نقطه هایی 

که خارج از شکل شما هستند را پاک کنید. )تصویر شماره 14(

از همان روش برای اضافه کردن دو ردیف پرچ دیگر در یک سوم پائینی راکت استفاده کنید.
)تصویر شماره 15(



براق کردن راکت :
راکت ما از ابتدای ساخته شدن درخشان بود!!! بگذارید کمی بازتاب بر روی آن خلق کنیم. بر روی 
یک لایه ی جدید یک منحنی سفید مخروط رسم کنید آن هم به وسیله ی ابزار  Pen  اینبار به 

Effect > Stylize > Feather و 3pixel را انتخاب کنید. . )تصویر شماره 15(

این مخروط را در مقابل Copy و Paste  کنید. Feather Effect  را حذف و یک شیب رنگ 
با افکت سفید به سیاه اعمال کنید. )تصویر شماره 16(

 Transparency Palette  هر دو قسمت مخروطی را انتخاب کنید در گوشه ی راست بالای
کلیک و Make Opacity Mask  را انتخاب کنید. )تصویر شماره 17(

تصویر 15

تصویر 16 تصویر 17

گام 5
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از شکل به وجود آمده یک کپی بگیرید و آنرا به قسمت پائین سمت راست که کدری %20 است ببرید.
)تصویر شماره 18(

تصویر 19

تصویر 20

تصویر 21

تصویر 18
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ترسیم پنجره ی راکت  :
یک بیضی آبی رنگ دقیقا در وسط رسم کنید ، از طریق همان روش قبلی نقاط پرچ را در اطراف 

آن تعبیه کنید. )تصویر شماره 19 و 20(

حالا پنجره را با یک شیب عرضی که که تاریکترین قسمت آن سمت چپ آن است پر کنید.مقداری 
طوسی روشن نیز برای از بین بردن سایه روشن های دیواره ی پنجره به آن اضافه کنید. سپس 

اطمینان حاصل کنید که رنگ دیواره ها از بدنه ی اصلی روشن تر باشد. )تصویر شماره 21(

گام 6



Effect > Stylize > Inner Glow and refer این مسیر برای اضافه کردن روشنایی محدودی 

به پنجره است، برای تنظیمات گزینه های کادر از شکل بعدی استفاده کنید . )تصویر شماره 22(

آخرین چیزی که باید اضافه کرد انعکاس نور به شیشه است. سایز کوچکتری از پنجره تهیه کنید و تمام افکت 
ها را پاک کنید. )تصویر شماره 23(

یک کپی دیگر از آن بگیرید آن را به دایره تبدیل کنید و سمت راست 
حرکت دهید. )تصویر شماره 24(

هر دو بیضی را انتخاب کنید سپس فاصله ی بین ابتدای بیضی اول تا ابتدای بیضی دوم را انتخاب کنید 
به طوری که یک شکل شبیه به حلال ماه بدست بیاید،آن را با رنگ سفید پر کنید . )تصویر شماره 25(

تصویر 22

تصویر 23

تصویر 24

تصویر 25
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بروید.    Effect > Blur > Gaussian Blur به 
)تصویر شماره 26(

  screen روی  به  را   blending حالت  نهایت  در 
بگذارید و کدری را تا %85 کاهش دهید. 

)تصویر شماره 27(

تصویر 26

تصویر 27

تصویر 28
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یک بیضی به رنگ زرد کم رنگ از پائین ترین قسمت گودی رسم 
کنید. Gaussian Blur effect اعمال کنید. 

حالت را به softe light تنظیم کنید و کدری را تا %90  کاهش 
دهید. سایه روشن ها را اطراف کار کپی کنید، برای شفافیت بیشتر 

کپی ها را بچرخانید تا با زمینه و بدنه ی راکت همخوان شود. 
)تصویر شماره 28(

گام 7



برای ساختن موتور یک کپی از بدنه تهیه کنید )به مرحله ی سوم مراجعه کنید( به سمت پائین scale می کنیم و 
به پائین بدنه حرکتش میدهیم و آن را با رنگ مسی پر میکنیم. )تصویر شماره 29(

یک تابش و نور درونی نیز اضافه میکنیم به شکلی که در حال خروج از اگزوز است. )تصویر شماره 30(

 gradient mesh ساده باله را رسم و آن را به path به وسیله ی یک
انتقال دهید. )تصویر شماره 31(

خطوط را تنظیم کنید و بر طبق شکل بعدی آنرا رنگ آمیزی کنید.
 )تصویر شماره 32(

تصویر 29

تصویر 30

تصویر 32تصویر 31
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گام 9



باله سمت راست را با یک کپی متقارن با باله ی سمت چپ خلق کنید. رنگبندی باید به طوری باشد که سمت چپ روشن و سمت 
راست در سایه قرار گرفته باشد. سپس با توجه به مرحله ی پنجم سایه روشن های قسمتهای مخروطی شکل را کامل کنید. 

)تصویر شماره 33(

یک سایه به باله چپ اضافه کنید. برای اینکار ابتدا شکل سایه را طراحی کنید با درصد کدری %35 آن را به رنگ سیاه در آورید. 
اگر از برنامه ی CS4 استفاده میکنید از روش opacity mask که در مرحله ی پنجم توضیح  داده ایم استفاده کنید،

 gaussian blur را نیز طبق شکل اعمال کنید. )تصویر شماره 34(

کمی  که  است  تصویری  این 
دور از ذهن بود.

)تصویر شماره 35(

تصویر 34

تصویر 35

تصویر 33
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تصویر زمینه را با آبی  روشن پر کنید که تداعی کننده ی آسمان باشد.نشان یا علامت اختصاری خود را 
نیز میتوانید اضافه کنید.که در اینجا من از لوگوی شخصی خودم که یک کد جعلی هم دارد استفاده کردم 
clf_2009 . در قسمت پائینی نیز دودهایی رسم کنید که دارای مرکز مشخصی باشند و به طور مداوم 

لایه های آن را تاریکتر کنید تا به مرکز دود برسد. سعی کنید دودها یک مقدار غیر عادی جلوه کنند.
 )تصویر شماره 36(

حالا تمام اشکالی که به عنوان دود رسم شده را انتخاب کنید و از کادر )gaussian blur (5PX را اعمال 
کنید تا زیبایی ان دو چندان شود. )تصویر شماره 37(

زرد  رنگهای  با  کردیم  رسم  را  دودها  که  همانگونه 
بیرون  موتور  ی  دهانه  از  که  ای  شعله  دو  ونارنجی 
می آید نیز میکشیم. همچنین چند ابر سفید رنگ در 

اطراف راکت. )تصویر شماره 38(

تصویر 36

تصویر 37

تصویر 38
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در انتها نیز چند دنباله در پشت باله ها برای نشان دادن حرک راکت.
در اینجا کار شما به اتمام می رسد. )تصویر شماره 39(

امیدوارم این تمرین تکنیکهای جذابی را به شما آموخته باشد.
موفق باشید ...

تصویر 39
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کاوه گلستان 17 تیرماه 1329در آبادان به دنیا آمد . تا 3 سالگی به سبب شغل پدر در آبادان 
زندگی کرد،) پدرش ابراهیم گلستان نویسنده و فیلمساز برجسته ایرانی آن سال‌ها برای شرکت 
نفت ایران و انگلیس کار می‌کرد.( در سال 1332 به تهران آمد و تحصیلات ابتدایی و متوسطه را 
در این شهر گذراند و پس از کسب دیپلم از دبیرستان البرز  برای ادامه تحصیل به لندن رفت، اما 
تحصیلات آکادمیک با روحیاتش جور نیامد . به ایران بازگشت و به عنوان عکاس و انیماتور در 
شرکت‌های تبلیغاتی نو پای ایرانی شروع به کار کرد. کمی پس از آن به مطبوعات رو‌ آورد و در 
اولین ماموریت مطبوعاتی‌اش به عنوان خبرنگار روزنامه کیهان رهسپار ایرلند شد تا از جنگ داخلی 

و ناآرامیهای آن کشور گزارش تهیه کند.
همزمان با کار در مطبوعات به گلستانِ پدر که دست به کارِ ساختِ دومین اثر سینمایی‌اش »اسرار 
گنج دره جنی« بود پیوست و به عنوان عکاس و مجسمه ساز با او همکاری کرد. دهه پنجاه برای 
کاوه گلستان سرشاز از تجربه و یادگیری است، در سال 53 او در گالری سیحون نمایشگاه عکسی 
با عنوان»کودکان ایران« برپامی‌کند و در همکاری با کانون پرورش فکری کودکان و نوجوانان، دو 
کتابِ »گلاب و قلمکار« را به چاپ می‌رساند و عکس‌هایی از کودکانِ گوشه و کنار ایران با نگاه 

کاوه گلستان در کتاب های درسی به چاپ می‌رسد.
محصول همکاری فعال و گسترده گلستان با روزنامه ها و مجلات داخلی و خارجی چاپ گزارش 
بار در روزنامه آیندگان منتشر  اولین  نامِ »روسپی، کارگر، مجنون« برای  سه‌گانه‌ای است که به 
گسترش  آرامی‌ها  نا  می‌اندازد،  پوست  ایران  جامعه  و  می‌رسد  فرا  پنجاه  دهه  دوم  نیمه  می‌شود. 
می‌یابد و انقلاب از راه می‌رسد. گلستان دوربین خود را به خیابان می‌برد واز رویداد های انقلاب 

عکاسی می‌کند .

کاوه گلستان به همراه خواهرش لیلی گلستان

نشان  تو  به  را  می‌خواهم صحنه‌هایی  »من 
و  بخورد  صورتت  به  سیلی  مثل  که  دهم 
امنیت تو را خدشه‌دار کند و به خطر بیاندازد. 
خاموش  می‌توانی  نکنی،  نگاه  می‌توانی 
کنی،  پنهان  را  خود  هویت  می‌توانی  کنی، 
مثل قاتل‌ها، اما نمی‌توانی جلوی حقیقت را 

بگیری، ‌هیچ کس نمی‌تواند.«
کاوه گلستان



این عکس‌ها جایزه رابرت کاپا را برای او به ارمغان می‌آورد و همکاری 
او با مجلات معروفی چون تایم، لایف، پاری مارچ و روزنامه گاردین او 
را به یک عکاس بین المللی بدل می‌کند. با شروع جنگ ایران و عراق 
در سال 59، کاوه گلستان با حضور فعال و دایمی در مناطق جنگی روی 
دیگری از واقعیات جنگ را به مخاطب نشان می‌دهد .شروع همکاری 

او  با آژانس‌های جهانی عکس هم در همین زمان رخ می دهد.
در طی این سال‌ها با همکاری گلستان و دوستانش کتاب‌هایی در زمینه 

جنگ و رویدادهای سیاسی کشور منتشر می شود.
کتاب »شورش« با همکاری »محمد صیاد« ، کتاب »جنگ« با همکاری 
»آلفرد یعقوب زاده« و کتاب »انقلاب نور« که یک کار گروهی است 
از جمله این کتاب‌هاست. در سال 1360 کتاب دیگری از گلستان با نام 
»غنچه ها در طوفان« منتشر می‌شود که حاوی عکس‌هایی از حضور 

کودکان و نوجوانان در انقلاب 57 است.
با پایان جنگ، گلستان دست به کار ساخت مستندی می‌شود پیرامون 
گریبان‌گیرِ  که  کتاب  چاپ  های  محدودیت  و  سانسور  بیان،  آزادی 
روشنفکران و نویسندگان است. در این فیلم او با روشنفکران مخالف و

و  می‌دهد  انجام  وگوهایی  گفت  هوادار حکومت  فرهنگیان  از  گروهی 
نظرات هر دو سوی مجادله را منعکس می‌کند .

 فیلم از کانال 4 انگلیس پخش  می‌شود و جنجالی به راه می‌افتد ،

مجوز فعالیت گلستان باطل می‌شود و او در پی این سکوت اجباری، در 
خلوت به تصویر برداری و تدوین مستند »گنگ خوابدیده« می‌پردازد. 
گروه  دعوت  به  او  و  می‌شود  برداشته  سال 1372  در  ممنوعیت  این 
هنر دانشگاه آزاد مشغول به تدریس می‌شود و همزمان همکاری خود 
را با خبرگزاری آسوشیتد پرس و بی بی سی از سر می‌گیرد که این 
همکاری تا سال 1382 و تا زمان مرگش ادامه می‌یابد. در این سال 
کاوه گلستان که برای تهیه مستند خبری برای شبکه بی بی سی به 
اثر انفجار مین جان خود را از دست می  مناطق جنگی رفته بود، بر 
دهد. او جایی در مورد هشت سال فعالیتش در جنگ گفته بود: »هشت 

سال از طریق دوربین و با یک چشم به چشمان مرگ نگریستم«
کاوه گلستان تنها عکاس ایرانی بین المللی نبود اما بی شک تاثیرگذار 
محسوب  ایران  عکاسی  اصلی  و  اصیل  های  ستون  از  یکی  و  ترین 
می‌شود. نگاه دقیق، جزئی و واقع‌نگرِ او فقط و فقط منحصر به خود او 
بود، خبرنگاری که تاریخ و واقعیات را به شکل خاص خود ثبت کرد، 
واقعیات اجتماعی، جنگی، انقلابی و انسانی را به تصویر کشید و جان 
خود را در راه ثبت یکی از همین وقایع تاریخی از دست داد و به قول 

دوستش محمد فرنود »کاوه هم یکی از عکس های جنگ شد. «
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مجموعه عکس های کاوه گلستان را می توان به دو 
بخش تقسیم کرد:

 پیش و پس از انقلاب
قبل از انقلاب مجموعه روسپی‌ها , کارگران و معلولان 

ذهنی که جزء معروف‌ترین آثار او هستند.
مجموعه روسپی‌ها بین سال های 54 تا 56 )در محله 
شهر نو تهران ( از زنان روسپی گرفته شده که شامل 

22 قطعه عکس است.
در این عکس‌ها، عکاس به نکاتی توجه کرده و آن‌ها 
را با دوربینش به ثبت رسانده که شاید کمتر کسی به 
این جزییات توجه کند اما کاوه گلستان به خوبی نگاه 

کرده و این نگاه را به ثبت رسانده است.
بار  نکبت  و  عادی  زندگی  تا  کرده  سعی  گلستان 
روسپیان را از ورایِ بد‌نامیِ محلی که در آن زندگی 
انسانی  ارائه نگاهی  با  و  بگذارد  نمایش  به  می کنند 

همدردی مخاطب را برانگیزد.

آثـار گلـــــستان :









گام بعدی در این مجموعه به عکس‌هایی که زندگی کارگران را در یک قالب 
اجتماعی و با دیدی انتقادی روایت می کند.

این نوع نگاه به الگویی برای بسیاری از عکاسان و فیلم سازان آینده بدل شد که 
پس از او و تحت شرایط اجتماعی آن زمان و آموزه های چپ در ایران پرداختند.





آخرین مجموعه از این سه گانه روایت زندگی در آسایشگاه روانی کودکان است، 
کودکانی که هم از طرف جامعه و هم خانواده خود به فراموشی سپرده شده‌اند. به 
قول خودِ گلستان »آنان زنده‌اند اما زندگیشان مشابه گیاهان است، همان گیاهانی 

که در گلدان‌ها و در گوشه و کنار اتاق‌های بیمارستان قرار گرفته اند. «





از این مجموعه سه گانه که بگذریم به عکس‌های او درباره انقلاب ایران می‌رسیم 
که شامل عکس‌های او طی سالهای 57 تا 59 است.

این عکس‌ها نسبت به تجربیات پیشین گلستان وجوه خبری ممتازتری دارد. با 
شروع نا آرامی های انقلاب ایران فصل جدیدی از کار گلستان آغاز می شود. از 
این رو او از معدود عکاسان ایرانی است که عکس‌هایش همزمان با انقلاب در 

نشریات معتبر جهان به چاپ می‌رسد. 
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مجموعه جنگ او نیز مواجهه بی واسطه با حقیقت جنگ است.از 
معروفترین عکس هایش عکس کودک قربانی جنگ تحمیلی در 
کردستان است با چشم مجروح باندپوش که با چشم سالم اش به 

دوربین نگاه می‌کند.
در مورد قیام کردستان در سال های 67 تا 68، گلستان عکس‌های 
بمباران  از  که  دارد  کردستان«  »قیام  نام  همین  با  تاثیرگذاری 
شیمیایی حلبچه که رژیم صدام آن را انجام داد، گرفته شده و در 
طول ی‌کسال به مبارزاتِ مردم کردستان و فجایعی که رژیم عراق 

انجام داده می‌پردازد.
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پس از مرگ کاوه گلستان کتابی با عنوان”ثبت حقیقت” با تلاش همسرش هنگامه در آلمان به چاپ 
رسیده است که شامل فعالیت های او بین سال های 1355 تا 1367 است.



اعلام نتایج نظر سنجی آثار طلائی 

انتخاب برترین اثر از بخش آثار طلائی درحالی به کار خود پایان داد که داوری این بخش به عهده شما عزیزان بود . بسیاری از دوستان همانگونه که در شماره قبل 
اعلام کرده بودیم از طریق پیام کوتاه و ایمیل اثر مورد نظر خودشان را انتخاب کردنند . از بین آرای شما 4 اثر با آرای بالای 25 عدد بودند که حدود %56 کل آرای را 

شامل میشدند . نمودار پایین شکل بهتری از انتخاب شما است .
با این حساب اثر آقای مرادزاده با کد 219 به عنوان اثر طلائی به گالری  آثار طلائی مجله فتوگراف اضافه شد . 

نمودار آثار منتخب شده شده شما با تعداد رای بالای 25 عدد





آثار طلایی
فتوگراف برآن است که در هر شماره خود آثار هنرمندان از قبیل پوستر ، عکس ، نقاشی ، کاریکاتور و تصویر سازی را انتخاب  و معرفی کند .

در شماره های قبل آثاری منتخب و به گالری ما اضافه شدن ، در شماره قبل داوری و انتخاب برترین ها را بر عهده شما گذاشتیم و شما بودید 
که از طریق پیامک و یا ایمیل به انتخاب آثارتان پرداختید.

شرایط شرکت در انتخاب برترین آثار ماه :
1.سیستم سامانه پیام کوتاه فقط یک رای را با هر شماره قبول میکند و از تکرار پیامک با یک خط بپرهیزید .

2.مهلت انتخاب آثار تا 20 روز بعد از انتشار مجله میباشد .
3.از نوشتن کلمات و نظراتتان در پیامک رای خودکاری کنید .

4. آثار باید حتما دارای مشخصات باشند.

Info@Gfx-Mag.com3000 6721 000 333SMS    : E-mail :
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آثار طلایی
حتما بخوانید ...

به منظور نظم بخشیدن در چینش تصاویر ارسالی و حرفه ای تر شدن گالری آثار طلائی ، تصمیماتی از اتاق فکر فتوگراف اتخاذ گردید که نتیجه 
این همفکر اضافه شدن شرایط جدید و به شرح ذیل به آثار طلائی می باشد .

1. آثار ارسالی باید تابع موضوع اعلام شده باشد. )موضوع آثار طلائی شماره آینده زمستان است(
2. آثار ارسالی باید با سایز 800 در 600 پیکسل ، فرمت Jpg  و با حالت رنگی RGB باشد .

3. در هر شماره 14 اثر انتخاب میشود و توسط شما داوری میشود .

Bestgfx.mag@gmail.com3000 6721 000 333SMS    : E-mail :



با فتوگراف دیده شوید. 
دیده شوید!!

Info@gfx-mag.com   تبلیغات در مجله



مهتاب جودکی



»انسانیت« برسد.آور شوند، آنجا که نگاهشان به سمت خط و کلمه برود و به تصویرِ سایه ی مردی در ذهنشان حک شود و »انسان« را یاد شنیدن اسمش کافی است تا آشنایان به رنگ، خط و قلم ، 

»رضا عابدینی«؛طراح و گرافیستِ خوب و کاربلد، که صفت »خوب« 
برایش بیانگرِ تمامِ خوبی ها است ، آغازگر تایپوگرافیِ  ایران است. اولین 
»مگز«  گرافیک  طراحی  تاریخ  کتاب  در  نامش  که  است  ایرانی  طراح 
)کتاب دروس دانشگاه های امریکا،استرالیا و کانادا( ثبت شده است و تا 
به امروز داور چند جایزه معتبر بوده و چندین جایزه بین المللی به خاطر 

آثارش دریافت کرده است.
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در ابتدا کلمه بود...
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متولد 1346 در تهران است . در نوجوانی، »عباس معروفی« ِ 
نویسنده، او را به هنر جذب کرده است.  به قول خودش، بر اثر 
یک اشتباه برای تعیین رشته، مرمت آثار باستانی در اصفهان را 
انتخاب کرده و همان را قبول می شود، و این دوره ی اجباری،  
تغییر  با  آورد.  می  فراهم  برایش  را  اسلامی  ایرانی  هنر  درک 
رشته اش به نقاشی، به دانشگاه هنر تهران می آید و در تردید 
عنوان  به   ، نقاشی  و  سینما  موسیقی،  گرافیک،  انتخاب  برای 
عشق و فعالیت حرفه ای، گرافیک را برمی گزیند و وارد این 

عرصه می شود. 
او که در شروع،آگاهانه  از استاد مرتضی ممیز و فرشید مثقالی 
ای  به شاخصه  در کارش  رفته  رفته  بود،  پذیرفته  زیادی  تاثیر 
برای خود رسید تا اینکه امروز؛ مردی که در پوستر هایش قدم 
می زند، رنگ خاکی مخصوصش و خطوط شکیل فارسی اش 

امضای آثارش شده است.
تمام تلاشش این بود که تصویری متعلق به خودش بسازد و 
این مهم انجام شد. او با الهام از موقعیت بومی خود گرافیک 
خاص خود را خلق کرد. در طراحی پوستر و جلد کتاب و لوگو 
گرافیک ایران را تحت تاثیر قرار داد، تاثیر فکری این هنرمند در 
دهه 60 و 70 مشهود است به طوری که حتی در صفحه بندی 

مجلات عناصر بصری سنت اسلامی را وارد کرد.
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عابدینی در جایگاه استادی ماهر طراحی گرافیک ، طراحی بصری ، 
چاپ ، طراحی پوستر، تایپوگرافی ، تایپ و تصویر را در دانشگاه تهران 
، مدرسه هنرهای زیبا ، دانشگاه آزاد ، دانشگاه الزهرا تدریس می کند 
و معتقد است که گرافیک از غرب وارد ایران شده است و بعد از درک 
گرافیک در غرب  می توان حق دخل و تصرف را در آن داشت ، به 
همین خاطر شاگردانش را وادار به مطالعه دقیق گرافیک غرب میکند، 

و بعد با آنها به بحث درباره گرافیک ایرانی می پردازد.

او در رسانه ای که در آن مشغول به کار بود به دنبال نوعی خودآگاهی 
می گشت و در پی این معنی که »متن و تصویر چه رابطه ای با هم 
دارند« به فعالیت پرداخت. به گرافیک مستقل از پیام فکر می کرد، 
چیزی که در آن تصویر حرف اول را می زند و متن تزئینی است  و 
منظر  مجله  جمله  از  بود  فعال  آن  در  که  نشریاتی  در  را  تفکر  این 

)زمستان 1377( پیاده کرد.
رکن اصلی کارهای عابدینی فونت فارسی است و همین پرداختن به 
این عنصر، و بهم ریختن حروف و کلمات مفهوم متفاوتی از حروف 
فارسی را خلق کرد. چیزی که پیش از تلاش او تنها با حروف لاتین 
کار می شد. در تلاش برای افزودن فضاسازی ایرانی به پوستر هایش، 
تا جایی پیش رفت که باوجود مدرن بودن فضای پوسترهایش، حتی 

بدون استفاده از بته و جقه، ایرانی بودن کارش کاملا پیدا است.
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معروف است به این که بدون کامپیوتر کار می کند، 
نیمی از آثار آرشیوی عابدینی به صورت دستی و 
از قدرت و  سنتی طراحی شده است و این نشان 

مهارت او دارد.
این طراح و گرافیست که در حال حاضر در آمستردام 
می  ادامه  هایش  فعالیت  به  و  دارد  هلند سکونت 
دهد، رعایت نکردن حق کپی رایت در ایران و کپی 
شدن را مشکل کار هنری امروز در ایران می داند 
و می گوید این عمل اجازه تجربیات شخصی را از 
تاریخ گرافیک و تجربه  نبود  هنرمند می گیرد، و 
در ایران را سبب فهمیدن موضوعات با ریسک و 
خطا در زمان خودش می داند اما در عین حال از 
اینکه در ایران و با شرایط سخت ایران در حرفه 
اش رشد کرده خوشحال است و می گوید اگر در 
کشور دیگری بود تنها یک طراح متوسط میشد و 

به این درک از گرافیک ایرانی نمی رسید.
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 رضا عابدینی در سخنرانی که در سال 2006 برای دریافت جایزه مطرح »پرنس کلاوس« 
حرف های خوبی زد: »در آغاز عهد جديد مي‌خوانيم که: »در ابتدا کلمه بود...« ودر فرهنگ 
و  خط  که  است  دليل  همين  به  حقيقت‌اند.  تجلي  محل  کلمات،  اسلامي،  عصر  ايراني 

خوش‌نويسي، شريف‌ترين هنرها نزد ايرانيان است. «



هيولايي كه نمي ترساند!
نقدي بر »هيولايي در پاريس«

انیمیشن کمدی ، عاشقانه ، ملودرام
Bibo Bergeron : کارگردان

90 دقیقه
IMDB رتبه 6.6 در

سال تولید : 2011

* اين نوشته با كمي تغيير و حذف در اولين شماره مجله »زير و بم« به چاپ رسيده است.

محمد بنائی
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سير تحول دنیای فیلم سازی، انیمیشن و سه بعدی در سال هاي اخير مسیری را در پیش گرفته است که دست اندرکاران صنعت فیلم سازی را به رقابتی 
جدی برای بهتر جلوه دادن آثارشان فراخوانده است و وسوسه ي بازي با اين تحولات، كارگردانان و تهيه كنندگان را هر روز به جاده ي رقابت مي كشاند.
در اين ميان توجه بیش از حد مخاطبان به اینگونه آثار، باعث شده است که بودجه ساخت این انیمیشن ها برای عقب نماندن از رقیبان روز به روز بالا 
و بالاتر برود، سوال اینجاست که آیا بودجه های میلیون دلاری نقش اصلی در جذب مخاطبان را ایفا کرده و جنبه ي مالي است كه به ماندگار بودن اثر 

کمک بالایی مي كند؟
گرچه چهل ميليون دلار بودجه براي خلق يك انيميشن سه بعدي كه »هيولا در پاريس« نام مي گيرد، رقم بزرگي است اما  اين تمام ماجرا نيست. ايده ي 
ساخت يك انيميشن در اروپا شكل گرفت، اروپايي كه انيميشن رونق چنداني در آن ندارد، و براي توليد آن مثل ديگر انيميشن هاي كمپاني هاي مطرح، 

اين شرايط سه بعدي  با  هزينه زيادي صرف شد، 
بودن اثر مي تواند امتيازي در كنار اين تلاش ها 
باشد اما تنوع در سلیقه گروه هاي مختلف مخاطبان 
پاسخ هاي متفاوتي به اين سوال مي دهد. از نگاه 
طراح شخصیت ها و عواملي كه در شخصيت نقش 
دارند، اين خودِ كاراكتر است كه به اثر قدرت می 
مدعی  نيز  آهنگساز  و  نویس  نامه  فیلم   ، بخشد 
هستند که زيبايي و جذابيت اثر به دستِ آنها بوده 
است و در آخر این کارگردانان هستند که میتوانند 
به سازنده های هر بخش از یک اثر امتیاز عادلانه 

ای بدهند.



انیمیشن فانتزی »هیولا در پاریس« محصول سال 2011 میلادی، اثري لذت بخش است که 
با خلق کارکتر ها و قصه زیبای خود جایی در دل دوستداران این حوزه از سینما را باز كرده و 

البته كاملا بي نقص نيست. 
صحنه هایی از شهر پاریسِ دهه ي اولِ قرن بيستم و شخصیتی به نام »امیلي«ِ آپاراتچي، 

»مائود«  و  دارد  در سر  را  كارگردان شدن  روياي  ِ قصه  آپاراتچي  اين قصه است.  سرآغاز 

روي  كه  بعدي  كاراكتر  است.  خبر  با  آرزو  اين  از  كه  است  تنها كسي  همكارش  و  دستيار 

صحنه مي آيد »رائول«، مكانكي و مخترع است كه با وجود علاقه ي اميلي به او، حسابي به 

كار خودش مشغول است. شخصيت ديگر اين انيميشن موزكيال »لوسيل« خواننده ي  زيبا 

و احساساتي است كه عمه اش براي شوهر دادن او تمام تلاشش را مي كند اما »مينوت«، 

رئيس پليس پولدار و قدرتمند، مرد روياهاي او نيست.

و اما هیولا حضور مي يابد و در اولین برخورد با لوسیل ترس زیادی به جان او می اندازد و 

بالاخره با او آشنا مي شود. مينوت براي ابراز علاقه به لوسيل پي فرانكو مي افتد تا او را به 

دام بيندازد و اميلي با پوشاندن لباسي سفيد و زيبابراي هيولا، او را به روی صحنه می برد و 

با  دادن گیتاری به دستش سعی در بهتر اجرا کردن این کنسرت کوچک دارد که با رقص 

هماهنگ با او یک شب شاد را برای او به ارمغان می  آورد. در یکي از مراسم هیولا شناسایی 

می شود و تعقیب و گریز در شهر پاریس اتفاق مي افتد، و نهایتا همه چیز در بالای برج ایفل 

به پايان میرسد .
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پاریس«،  در  ِ»هیولایی  فرانسوي  کارگردان  »بیبوبرژرون« 
كمپاني  كار  كهنه  همكاران  از  او  است.  اي  تجربه  با  انیماتور 
چون  موفقي  فیلم‌هاي  وکارگردانی  است  وركز«  »دريم  مطرح 
»جاده الدورادو« و »قصه کوسه« را درکارنامه خود دارد، و »لوك 
بوسون«ِ مشهور تهيه كننده اين اثر است كه وجود او به عنوان 
يك تهيه كننده بين المللي امتياز بزرگي براي برژرون و هيولاي 

او باشد
و  بازي  اسباب  داستان  نمو،  جستجوي  در  ها،  هيولا  .كارخانه 
شرك انيميشن هايي بودند كه در ساخت آنها  صداي بازيگران 
هاليوودي و طنز لازم به كار گرفته شده بود، چيزي بيشتر از يك 
فيلم براي كودكان هستند. با توجه به روند فيلم هاي انيميشن 
تنها  نه  بعدي  انيميشن هاي سه  اخير،  تا كنون، در سال هاي 
كودكان بلكه زنان و مردان بزرگسال را هم به خود جذب كرده 
است اما »هيولايي در پاريس« ديگر طرفداران انيميشن را چندان 
راضي نكرد. اين اثر متاسفانه فاقد شور و هيجان، سرعت و طنز 

است كه فيلم هاي انيميشن ديگر در اين سبك ارائه داده اند.



اند درست  بوده  این کارتون 90 دقیقه موفق  تیم حرفه ای خود در ساخت  و  برژرن  بیبو 
است که منتقدان زیادی را به دور خود جمع کردند و در »IMDB« رتبه بالایی نگرفتند اما 

توانستند خالق یک اثرِ توليدي خوب و ماندگار باشند. 
داستان كلاسيك اين فيلم كه در كنار وجه سرگرمي، براي كودكان پيامِ تلاش براي درك 
حقيقت و حس همياري و گذشت را در بر دارد. تريكب فيلمنامه ي عجيب و قوي ِ»بيبو 
پارادیس،گاد  ماتیوشدید، ونسا  با حضور صداپیشگانی چون  برژرن« و »استفان كزانيژان« 
المالی، فرانسوا کلوزه و لود یوینسانیهدر»هیولایی در پاریس« مطمئناً تنها عوامل استقبال 

مخاطب از اين كار نيست.
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منتقدین  دید  از  است،  عاشقانه، کمدی  ملودرام  های  دارای شاخصه  که  اثر کلاسیک  اين 
فرانسوی و یا دیگر منتقدین هم مورد نقد و بررسی های زیادی قرار گرفت .خيلي از منتقدین 
به کارگردانی جوئل شوماخرو  اپرا  یا شبح  و  دلبر  و  دیو  آثار  از  الگو گرفته  را  انیمیشن  این 
آهنگسازی اندرو لوید وبر که بر اساس رمان شبح اپرا نوشته ي نویسنده ي فرانسوی گاستون 

لورو می دانند و معتقدند حتي نام های انتخاب شده بسیار به این اثر نزدیک هستند.
انتخاب موسیقی و آهنگسازی قوی »ماتيو شديد«،  قدرت عاشقانه و ملودرارم بودن این کار 
را افزایش داده و نقش لوسیل را نسبت به دیگر شخصیت ها متمایز کرده است تا جایی که 

مخاطب ارتباط احساسي خوبي با این انيميشن برقرار مي كند.
برژرن كه اين روز ها در فكر ساخت قسمت دوم »هيولايي در تاريكي« است در مصاحبه 
اي درباره اولين نمايش عمومي فيلمش مي گويد: »احساس غرور ميك‌ردم وخوشحال بودم 
براي  را  آن  مي‌توانستيم  كاري،  خوب  گروه  يك  كنار  در  سخت  كارِخيلي  يك  از  بعد  كه 
عموم تماشاگران به نمايش بگذاريم.  مي‌دانيد،وقتي تماشاگري به شما مي‌گويد فيلمي كه 
ديده‌ام يك انيميشن خوش‌ساخت و جذاب است و هنگام تماشاي آن احساس لذت كرده‌اند، 
خشنود مي‌شويد و حس ميك‌نيد مزد كارتان را گرفته‌ايد. بسياري ازتماشاگران كاراكترها و 
شخصيت‌پردازي قوي حرف مي زدند و من دقيقا احساس ميك‌ردم آنها چيزي را كه مد نظرم 

بوده،‌ درك كرده و فهميده‌اند.«
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زمستان شما چگونه میگذرد؟
زمستاناز کنیدعکاسی
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گفت وگوی اختصاصی با

عکاس موفق مقیم کانادا

امیر علی شریفی



هفت سالی می شود که عکاسی را به صورت 
کند.  دنبال می  اش  عنوان حرفه  به  و  جدی 
29 ساله است و دانشجوی دکترای کامپیوتر. 
مربوط  عکاسی  به  او  دانشگاهی  تحصیلات 
نیست و حول محور علوم کامپیوتر می گردد. 
مطرح  را  شریفی  امیرعلی  نام  آنچه  اما 
کرده تلاش او در عکاسی خیابانی و همکاری 

او با روزنامه The Gateway است. 
عکاسان  انجمن  در  عضویت  این  بر  علاوه 
انجمن  همینطور  “NPAC”و  کانادا  خبری 
خبرنگاری دانشگاهی کانادا“ CUP “از فعالیت 
است.  موفق  جوان  عکاس  این  کنونی  های 
گفت و گوی فتوگراف با امیر علی شریفی  را 

در ادامه می خوانید: 

امیرعلی شریفی عکاسی را از کجا شروع کرد ؟

پاسخ به این سوال بستگی به تعریف شما از شروع عکاسی دارد. اگر شروع عکاسی را زمانی درنظر 
می گیرید که شخص به صورت فعال، به صورت جدی یا برای لذت شخصی، شروع به گرفتن عکس 
می کند حدود 21 ساله بودم. در سال 82 بود که در کنار فعالیت موسیقی، به عکاسی هم علاقه مند 
شدم و با دوربین دوستم که با هم ساز میزدیم و دوربین خواهرم و از سن 23 سالگی با دوربین که 
از مادرم هدیه گرفتم عکاسی می کردم. ولی برای من شروع عکاسی زمانیست که اولین بار عکسی 
با مضمونی غیر از عکسهای روزمره و خوانوادگی دیدم و در آن لحظه درک کردم که این عکس با 
هدفی متفاوت گرفته شده و شاید مضمونی فرای صرفا یک عکس روزمره دارد. آن روز ایده ی اینکه  

“عکاسی چیزی فرای عکس های زورمره است” در ذهنم شکل گرفت.
شاید این اصطلاح “برق گرفتن” که عکاسانی مثل “برسون”، در مواجهه با عکس پسرانی که به 
این زبان  توانایی  به  برند و باعث شد که  از “مارتین مونکاسی” به کار می  سمت دریا می دویدند 
تصویری برای بیان پی ببرند و شروع به عکاسی کنند تا حدی در مورد من هم صادق باشد. به این 
صورت که در آن لحظه هم برق ضعیفی من را گرفت. گفتم “تا حدی” چون چندین سال بین دیدن 
این عکس که به صورت تصادفی در مغازه ای که کارهای معماری خواهرم را چاپ می کرد با زمانی 

که من شروع به عکاسی کردم فاصله بود.
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تفاوت عکاسی در ایران و کانادا در چیست و آیا اختلاف فرهنگ 
جوامع است که مسیر عکاسی را عوض کرده ؟

ایران  با  را  کانادا  در  عکاسیم  تجربه  از  بخشهایی  میتوانم  فقط  من 
مقایسه کنم که فعالیت مشابهی در هر دو کشور داشتم. به عنوان مثال 
من در روزنامه ای در ایران کار نکردم و از طریقه کار خبرنگاری ایران 
مطلع نیستم. در مورد عکاسی اجتماعی، مستند و خیابانی تفاوتهایی 

هست که در این زمان بیشتر هم شده است.
 البته حتی بین شهرهای مختلف ایران هم تفاوت های زیادی هست. 
با شهرکرد  به عنوان مثال عکاسی خیابانی در همدان بسیار متفاوت 
است شاید به علت تفاوت فرهنگی، جهت های متفاوتی که شهرها در 
زمانهای مختلف رشد کردند و غیره. تجربه شخصی من این بوده که 
مثلا در همدان یا تهران مردم بسیار نسبت به عکاسی خیابانی پذیرا تر 

هستند تا به عنوان مثال شهرکرد. 
و  فرهنگ  در  کانادا  و  ایران  بین  خیابانی  عکاسی  تفاوت  از  بخشی 
دینامیک جامعه نهفته است. همیشه تصورم این است که در کشور ما 
و بعضی کشورهای خاورمیانه زنانِ عکاس آزادی عمل بشتری نسبت 

به عکاسهای آقا دارند. 

مسئله اعتماد در عکاسی مستند بسیار تعیین کننده است و کسب این 
اعتماد به دلایل اجتماعی و فرهنگی برای زنان شاید قدری ساده تر 
باشد. در کشور کانادا بنده با چنین پدیده ای مواجه نشدم و تفاوتی در 
پذیرش برای عکاسهای آقا و خانم حد اقل در سطح کلان وجود ندارد. 
تفاوت دیگر به نظر کمرنگ شدن عکاسی خیابانی در ایران و  رشد هر 
چه بیشتر آن در کاناداست. دوستانی که در ایران به همراه من چندین 
عکاسی  به  مختلف  علل  به  اکثرا  کردند،  می  خیابانی  عکاسی  سال 
هم  اروپایی  کشورهای  در  پدیده  این  البته  آوردند.  روی  استودیویی 
به چشم میخورد. مثلا تغییر قوانین در چند سال اخیر در فرانسه، کار 

عکاسان خیابانی را با محدودیت های فراوانی مواجه کرده است. 
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علی رغم این مسایل کارهای مستند خوبی در چند سال اخیر از ایران می بینم که بسیار امید بخش و 
خوشحال کننده است. قوانین در کانادا به غیر از ایالت کبک به عکاسان خیابانی آزادی عملی می دهد 
که با ایران متفاوت است. البته وقتی در مقام مقایسه بر می آییم باید تفاوتهای فرهنگی و اجتمایی را 
هم در نظر بگیریم. رشد عکاسی خیابانی در کانادا را می توان در انجمن های عکاسی خیابانی، حتی 
در شهرهای کوچک دید که دائم در حال شکل گیری هستند. به نظر من مواجه شدن افراد یک شهر 

با پدیده عکاسی خیابانی هرچه بیشتر دیدگاه آنها را نسبت به این مسئله بازتر می کند.
دیگر تفاوت عمده بین عکاسی در کانادا و ایران دسترسی به امکانات است. امکاناتی که از طریق گروه 
های خودجوش عکاسی، گروه های دانشجویی، دسترسی به منابع از طریق کتابخانه ها و دانشگاها ، و 
دسترسی به کارگاه های عکاسی وجود داردفرصتی را برای افرادی که بخواهند از این امکانات استفاده 
کنند فراهم می کند. به عنوان مثال مطالعه در زمینه عکاسی و دیدن کتاب ها و کارهای عکاسان 
بزرگ بسیار در دسترس تر از ایران است. من از میزان ترجمه در زمینه عکاسی در سالهای اخیر ایران 
اطلاع ندارم ولی شاید دسترسی به کتاب ها در فضای اینترنت در حال کم کردن این فاصله است. 

البته در نهایت این بستگی به شخص دارد که به چه میزان از این امکانات استفاده کند. 
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آثار شما  به عنوان عنصر غالب در   ، دلیل وجود اشخاص و جامعه 
چیست و دیگر عناصر شاخص در کارتان کدامند؟

من  برای  که  عناصری هستند  از  من  های  در عکس  مردم  و  اشخاص 
اهمیت ویژه ای دارند تا جایی که حتی اگر شخصی نباشد به نوعی به 
دنبال نشان دادن رد پای مردم در عکس هایم هستم. علت وجودی چنین 
برمی  مردم شناسی  و  فرهنگ شناسی  به  ام  به علاقه  من،  در  کششی 

گردد. 
داستان و بیان دیدگاه از طریق عکس، عنصر دیگریست که اهمیت ویژه 
بیان  برای  این است که عکسم مدیومی  دارد. تلاش من  برای من  ای 
دیدگاه یا نقل داستانی مستند باشد که مد نظرم است. روایت تصویری یا 

داستان گویی تصویری زمینه مورد علاقه من است. 
عنصر نهایی هم برای من ترکیب های گاهی انتزاعی با استفاده از شکل، 
مردم،  داستان  نقل  در  سعی  اصولا  من  عکسهای  است.  رنگ  و  فرم 
اشخاص و فرهنگ یه منطقه را دارند، ولی رنگ و فرم عناصری هستند 
که گاهی اهمیتی بیشر حتی از موضوع پیدا می کنند تا حدی که عکس 
فرم گرافیکی پیدا کند به جای اینکه سندی در راستای داستانی ارایه دهد. 
کنجکاوی من به مردم و علاقه به نشان دادنشان در لایه های مختلف 
عکس برای بیان مفهوم و برداشت شخصی از موقعیت با استفاده از عناصر 

گرافیکی شاید سه عامل گرایش من به عکاسی خیابانی هم باشد.
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آیا تاکنون نمایشگاه و یا گالری برگزار کرده اید؟

نمایشگاه شخصی خیر، ولی در چندین نمایشگاه گروهی در ایران، سویس و 
کانادا شرکت کردم. اولین نمایشگاه گروهی به نام “دنیای سبز من” بود که 
در تهران توسط وبسایت فوتو دات آی آر برگزار شد.)از کارهای برگزیده که 
برای وبسایت ارسال شده بود.( نمایشگاه “ما همه عکاس هستیم” هم در 
دانشگاه “ایی پی اف ال” سویس برگزار شد. نمایشگاهی با موضوع سایه ها 
هم به صورت گروهی با جمعی از عکاسان روزنامه The Gateway در کانادا 

برگزار شده که در آن هم شرکت داشتم.

جایگاه خودتان در حوزه عکاسی را چگونه می بینید؟

سوال مشکلیست.  روند فکری، مطالعاتی و کاری من دایما در چند سال 
اخیر من را به سمت کارهای مستند فرهنگی و خیابانی سوق داده است. نگاه 
به عکاسی به عنوان ابزاری برای بیان برداشت و دیدگاه شخصی نسبت به 
فرهنگ یک منطقه یا طریقه زندگی افراد یک گروه از مردم یا نشان دادن 
مسایل اجتماعی عمدتا فرم دهنده فعالیت عکاسی من بوده و روز به روز 
ام.  با عکاسی صرفا خبری یا صرفا  هنری حس کرده  را  فاصله بیشتری 
تمرکز بیشتر من در آینده بر روی کارهای مستند و پروژه های بلند مدت 
خواهد بود که شاید به فرم Photo Essay  یا نمایشگاه یا در صورت موفقیت 

به صورت کتاب در بیاید.

به حس  و  بینید  می  دیگران  از  متفاوت  را  یک  کدام  آثارتان  بین  از 
درونی خودتان نزدیک تر می دانید؟

هر کدام از کارها برای من اهمیت ویژه ای در زمان انجامشان دارند حتی 
اگر بعد به علت تغییر مسیر فکری و دیگاه یا مواجه شدن با مسایل دیگر 
جای خودشون رو به مسایل دیگری بدهند. شاید photo essay  که به نام 
مکالمه ای به زبان فرانسوی کانادایی منتشر کردم در مورد خیابانهای قسمت 
 Untitled(   بینام photo essay  های قدیمی مونترئال و کبک سیتی و
Photo Essay The(  که در مورد کنجکاوی در سایه روشن های مرکز شهر 

ادمونتون بود جزو کارهایی باشند که اخیرا انجام دادم و دوست داشتم. از 
بین کارهای قدیمی تر پرتره های خیابانی که در تهران و شهرستان ها در 
اطراف بازارهای سنتی گرفتم بیشتر برایم متمایز است.  بیشترین عکسم که 
دیده شده هم عکس رعد و برق ساحل محمود آباد بود که به عنوان عکس 
و صفحه  وبسایت  توسط  دیگر  مناسبت  چندین  و  جئوگرافیک  نشنال  روز 

فیسبوک این موسسه نشان داده شد. 

حرف آخرتان برای علاقمندان به عکاسی و خوانندگان فتوگراف ؟

از شما برای این فرصت و مصاحبه بسیار متشکرم. امیدوارم هموطنانی که 
به عکاسی علاقه دارند مطلالعات عکاسی خود را بیشتر کنند و عکس خوب 

زیاد ببینند. 
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هرچه رو به جلو میرویم نیاز هایی رو حس میکنیم تا بتوانیم ارتباط بهتری با خوانندگان مجله و دوستدارانمان داشته باشیم ، مخاطبان جدیدی هم روز 
به روز به ما و مجله پیوند میخورند که شاید سوالات و نکاتی برایشان پیش بیاید که ما همه ی این سوالها را در این بخش جدید به نام پاسخ جواب 

خواهیم داد . 
در ابتدا ما سوالات متداولی  که به از ما پرسیده میشوند را به جواب میدهیم . سوالات میتوانند در مورد مجله ، گرافیک ، عکاسی  و .. باشند . 

 شما میتوانید سوالات خودتان را از طریق پیامک و یا ایمیل برایمان ارسال کنید.
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آیا مجله شما را میتوانیم از دکه های روزنامه فروشی خرید ؟

من چند باربعد از دانلود مجله را باز کردم اما قادر به باز کردنش 
نشدم ، لطفا راهنمایی کنید که با چه نرم افزار هایی باز میشود؟

خیر ، مجله فتوگراف همانطور که از نامش پیداست به صورت مجازی و 
الکترونیکی ، با فرمت پی دی اف عرضه میشود و رایگان میباشد .

دوست و خواننده عزیز مجله را باید با نرم افزار هایی که فایل های پی دی اف 
را میتوانند اجرا کنند باز کنید

 مثلا Adobe acrobat  یا Adobe reader  این نرم افزار ها را 
میتوانید در وب سایت مجله دانلود کنید .



وقتی مجله را در فتوشاپ باز میکنم پسورد میخواد ، لطفا راهنمائی 
کنید ؟

بنده چند مقاله دارم در مورد هنر میتوانم آنها را برای انتشار در مجله 
برای شما ارسال کنم ؟

موضوع آثار طلائی را در کجا میتوانم ببینیم که آثارم را برایتان 
بفرستم ؟

 پسورد فوق برای امنیت مطالب و عدم تغییرات در مجله می باشد که از 
سوی ما تعبیه شده است.

بله ،  مطالب و مقالات باید نوشته شده توسط خودتان باشد. 

دوست گرامی سوال بسیار خوبی بود ، ما در ابتدا برای ایکه شناخته شویم 
موضوع خاصی را برای آثار طلائی در نظر نمی گرفتیم اما ازاین شماره به 

بعد آثار ارسالی باید در چارچوب موضوع باشد .
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فایهایی که  در  آموزش استفاده میشوند را چطور باید دانلود کرد ؟

در مورد همکاری با مجله توضیحات کاملی ارائه میکنید ؟

فایهای مربوط با آموزش و کاربردی مجله را در وب سایت مجله و در زیر 
لینک دانلود مجله میتوان پیدا و دانلود کرد.

دوستدارن  شما  از  که  شد  منتشر  ما  با  شما  همکاری  بر  مبنی  فراخوانی 
 ، گرافیک   ، عکاسی  زمینه  در  همکاری  به  مایل  اگر  که  شد  خواسته 
نویسندگی افتخاری  با مجله فتوگراف را باشند از طریق ایمیل مجله با ما 
در تماس باشند ، یکی از شرایط مهم این همکاری این است که آموزش 
ها و مقالات ارسالی توسط شما باید نوشته خودتان باشد و این مقالات و یا 

آموزش ها با نام و ایمیل شما در مجله منتشر میشود . 
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سوالات میتوانند در مورد مجله ، گرافیک ، عکاسی و .. باشند.  
شما میتوانید سوالات خودتان را از طریق پیامک و یا ایمیل 

برایمان ارسال کنید.

3000 6721 000 333SMS :



انسانم!

میخواهد
 بی هنرترینو من 

کردن تو
فراموش

هـــنر 

www.Gfx-Mag.com






